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Preface

We wrote the Effective Series because we wanted a computer application text-
book to help us teach. At the time, most computer applications texts were writ-
ten like cookbooks. Do this, do that, follow these steps. There was little or no
explanation about why you should carry out specific tasks. Most books simply
described a series of elaborate keystrokes. While these types of textbooks work
fine as a personal reference, they did not help us to teach or our students to
learn. These types of texts certainly did not help our students master computer
applications with a high degree of understanding. Unfortunately, the trend con-
tinues where too many authors follow this cookbook approach.

One of the primary reasons so many applications books fail as instructional
tools is that most current computer applications texts are not written by peo-
ple like us, people who teach in the classroom. Unlike our Effective Series, most
applications texts were, and still are, written by professional writers—people
who have not been in the classroom in recent years or who have never taught.
Their books are not guided, or revised, on the basis of teaching experience,
experience working with students on a day-to-day basis, or on an ongoing edu-
cational pedagogy. Our goal was to take our ongoing classroom experience and
classroom pedagogy and use it to guide us in the development of a computer
text that would serve as a true instructional and learning tool. The outcome of
this effort is a pedagogical model we call Success-Based Learning.

SUCCESS-BASED LEARNING

Success breeds success. You may have heard this simple statement before. As sim-
ple or as trite as this statement may sound, it is at the basis of our thoughtfully
planned instructional pedagogy. We base our Success-Based Learning pedagogy
on one primary assumption—the most successful teachers are those who have a
strong desire for all students to learn. This desire serves as a threshold in the
sense that teachers who want their students to learn, and who hold high expec-
tations for student learning, have students who are successful in the classroom.
Putting high expectations into practice is the foundation for the five princi-
ples in our Success-Based Learning model. By combining five separate elements,
students learn the material quicker, have a better understanding of how soft-
ware operates, and retain and recall the material easier. It also makes it easier
to teach. Most of our principles are based on social psychological theories that
have been around for a long time. They are not new, nor are they exclusively
ours. What is different here is that we have taken principles we use to teach in
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the classroom and have used these principles to guide us in writing this series
of books.

Learning is most likely to occur when students make a decision that they
want to learn. If a student makes a conscious decision to learn something, and
the teacher also wants that student to learn, the teaching—learning process
becomes very easy. Unfortunately, in many instances this is not the case. One
of the benefits of Success-Based Learning is that it provides a motivation, and
a stimulus, to help students develop a desire to learn.

1. Structured success. Generally, when attempting any new behavior, if peo-
ple experience immediate success they become more willing to try additional
behaviors in that activity. On the other hand, if they experience failure, they
become reluctant to attempt any further activity. Students need the opportunity
to experience their own victories in order to reinforce what they learn and instill
confidence in their ability. So, we provide highly structured activities and tightly
correlated exercises early in every lesson. These activities and exercises are
designed to provide opportunities for immediate success. When students experi-
ence this early success they are more likely to make a decision they want to learn
more.

2. Identifiable outcomes. Students learn with confidence when they can
anticipate the results of their work. In other words, students must know when
they have learned something correctly. The important component here is not
that students must know when they have learned something, but that they have
learned it correctly. The example we like to use here involves the activity of
making an omelet. Before you start to make an omelet you should know what
an omelet looks like. This way, you will know if you have been successful in
your attempt. Otherwise, when you try to make an omelet you might end up
with some concoction of eggs and other ingredients that looks vaguely like
scrambled eggs and not realize that you have made a mistake.

Each of our lessons begin with a set of objectives, followed by an extensive
overview of what students can expect as they proceed through the lesson. We
include several screen shots to show students exactly what to expect from their
actions. Further, each major section within the lesson begins with a conceptual dis-
cussion of the reasons why an activity is important, what outcome should be gained
from the activity, and how this is related to the overall goal of the lesson. From
this, students know what to expect throughout the lesson and what they should
understand at the end of the lesson. They know when they have been successfiil.
Knowing when you have been successful is key in learning any behavior.

3. Guided exploration. Most of us agree that the best way to learn how to
use software is to use it to solve a problem. But, this “hands on” approach
should not be left to trial and error learning. It is important to provide a step-
by-step road map through each new topic. This is the explanatory aspect of lec-
turing or working through class activities. It may also be referred to as the “How
to” component of instruction. The goal here is to explain how to use this new
idea, or new information, in their own experience.

We include several exercises in each lesson that are directly tied to an activity
that is carried out throughout the lesson. Not only are these exercises tied to an
activity, we provide several applications at the end of each lesson that are linked
directly to lesson objectives. In this manner, students are provided with a map. That
is, they are guided very closely toward achieving the objectives of each lesson.

Exercises embedded throughout each lesson and application projects at the
end of each lesson provide personally meaningful experiences throughout the
learning process. In addition, we also provide a series of data disk applications



which allow students to expand their understanding by modifying files. We also
provide a comprehensive problem at the end of the lesson which is designed to
link concepts in previous lessons to the current lesson. This helps students
understand the connection between concepts and processes throughout the
entire learning experience.

4. Deductive reasoning. We think it is best to provide students with broad
general principles and then reduce these global conceptions to more specific,
existential ideas or components. Most scientific reasoning is deductive rather
than inductive, so it makes sense to follow this model when teaching scientific
subjects. The second lesson of each module introduces students to the broad
general, or global, aspect of the software. That is, in Lesson 2 of every module,
students create a document, spreadsheet, or database. They learn to edit,
change, save, and print the file. In each subsequent lesson the global commands
introduced in Lesson 2 are broken down to their basic components and used as
the basis for conducting additional activities. By moving from a global proce-
dure in Lesson 2 to more specific activities in subsequent lessons, retention and
recall is facilitated. Helpful Hints are also used to suggest alternative strategies
for a task or to provide very brief instruction on a limited topic. The combina-
tion of Helpful Hints and the organization of each book on the basis of pro-
ceeding from general to more specific topics helps facilitate retention and recall.

5. Critical mass. This is an aspect of teaching that comes with experience
and ongoing contact with students. Those of us who teach must carefully deter-
mine how much material we can safely introduce in one lesson. Too much and
the student is overwhelmed. Too little and the student is not challenged. Iden-
tifying the critical mass for a classroom lecture, chapter topic, or even an entire
course becomes a crucial variable for successful instruction. With an introduc-
tory course on computer applications, not everyone needs to know every com-
mand, every procedure, or every nuance of a particular piece of software. What
is important, however, is that a student learn enough to feel comfortable with
what they have learned, and feel comfortable enough to experiment. In several
of the applications at the end of each lesson, we provide activities designed to
encourage students to experiment.

Would you prefer a textbook written by professional writers who have not
stepped into a classroom in several years, or who may have never been in the
classroom? Or, would you rather use a textbook written by people who teach,
who care about their students, and want their students to learn? We know this
pedagogy works.

Preface

ix



LESSON 2 OBJECTIVES

Alter completin

-

First Document

Creating a document with Microsoft Word is not difficult. In fact, there are only
a few simple rules for creating documents. This lesson focuses on the basic ele-
ments of creating simple documents. These elements are presented in a step-
by-step fashion.

The first step in creating a new document is to enter text. Writing with a
word processor allows you to enter text in any form and then edit the text later.
Although it may seem unusual to people who are new to word processing, the
most efficient method for creating a document is to emphasize ideas rather than
being overly concerned about spelling, layout, or even grammar. It is best just
to write one’s ideas down roughly and not to worry about cleaning up the doc-
ument until later.

After entering an initial draft, the next step is to edit. Editing is nothing
more than deleting undesired text and inserting correct text. There are two
methods, or modes, for placing text. The Insert mode inserts text into a line
without erasing what was typed previously. The Overtype mode allows new
text to be typed directly over old text. Using these two techniques makes edit-
Ing easy.

After you create and edit a document, it is crucial to save it on a disk. After
all, as soon as the computer loses power all information, including a newly cre-
ated document, is erased from memory. Placing the document on a disk stores
it for future use. Saving is therefore an essential step in creating any document.

After saving a document, the next step is to send the document to the printer.
Printing is not very difficult, but before trying to print you should understand
the relationship between Microsoft Word, Microsoft Windows, and the printer.

The final step is to exit Microsoft Word correctly. One common mistake made
by new users of Microsoft Word is to exit incorrectly. This can cause a loss of
part or all of a document. It can also cause some confusion when re-entering
Microsoft Word.

S —— p—— ™



ACTIVITY

1. Point and ciick the mouse on the View menu and make sure the All
Characters command is selected.
A check mark will appear next to All Characters, which indicates this
command is active. Also notice the paragraph mark appears at every location
where you pressed Enter, and that dots appear at every location where you
pressed the spacebar (Figure 2—10).

Figure 2-10
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Move the insertion point in several directions with the arrow keys. Any
time you insert a nonprinting character it appears in the workspace.
Click on the All Characters command again to toggle off this command.




Use the All Characters command in the View menu to view the document with para-
graph and space marks. Delete all paragraph marks, and then disable the All Characters
command. After deleting all these marks, reinsert them to restore the document to its
original form. Leave the All Characters command disabled.

SAVING A DOCUMENT

Now that you have created your first document, it is time to save it. There are
many reasons to save. Obviously, you want to save a document before you turn
off your computer or start creating another document. In addition, saving should
occur at various times while creating a document in the event that something
happens to your computer or the power unexpectedly goes off. There is one
other reason to save: Printing can cause problems that range from failing to
print to “locking” your computer. For such reasons, it is a good idea to save
your document before you print.

Works offers two ways to save a document. The first method is through the
Save command in the File menu. Clicking on the Save button on the toolbar
has the same effect as selecting the Save command. The other way is through
the Save As command in the File menu.

To save a document for the first time, you should select the Save As com-
mand from the File menu. This produces the Save As dialog box. You may click
on the Save button to produce the Save As dialog box if you have not previ-
ously saved the document. There are two important considerations when sav-
ing the file: the location and the filename. You specify the location first by set-
ting the location next to Save in: in the Save As dialog box. For saving your

document on a floppy disk, you normally select 3%
Floppy (A:) under My Computer.

Where files are stored is of utmost importance.
After all, if you cannot locate the files you need, you
cannot fully use the word processor. You may save
your documents in any folder or on any disk that you
like. However, there are pros and cons for each loca-
tion. For example, storing data on a hard disk in a
folder is convenient, but leaving files on a hard disk
makes them available for any other user. If you are
working in a computer lab, storing your files in a
folder on a hard disk for public consumption may be
disastrous. Also, you must use the same computer
every time you want to retrieve your document. For
these reasons, it is important to store all files on your
own floppy disk.

When you select Save As, the Save As dialog box
appears. To specify the A: click on the arrow next to
the text box for Save in: A listing of available disks
and folders appears. To save your document on your
own floppy select 3% Floppy (A:) under My Com-
puter. This is critical. One of the most common mis-
takes made by new users is to fail to set the location
before saving the file.




APPLICATION PROJECTS —

1. Type a letter to a parent, friend, or spouse. Include such topics as why you
are typing this letter, the weather, what you are doing in your spare time,
when you will visit, or any other topic you choose. After typing several
lines, use the insertion point keys to move around the text. Practice insert-
ing new sentences in the middle of the document. Make your letter at least
two paragraphs long. Print a copy of the letter.

. Return to the letter typed in Application 1 of this lesson. Use the Over-
type option to replace entire sentences in your letter. Be sure to watch the
monitor, and toggle (switch on) the Overtype mode on or off at the appro-
priate location in your letter. Print a copy of the revised letter.

. Again, using the letter typed for these applications, use the All Characters
command, then insert returns in the middle of several words. Observe the
effect of these returns, then use the All Characters command to delete
these returns and to restore the document to an appropriate style.

. Type a letter to a local retail store. Indicate in your letter that you would
like to order an item that they do not have in stock. Indicate where you
saw such an item, the approximate price, and any other description you
think is important. Be sure to include your name, address, telephone
number, and any other pertinent information. After completing it, edit
the letter until you are satisfied with its contents. Save and print the
letter.

. Mary Jones is attending Alright College. Mary is happy, but she could use
some extra spending money. Mary notices a want ad on the bulletin board
for a person with computer, typing, and filing skills. Mary has all these skills
and decides to apply. She comes to you and asks you to write a letter of
recommendation about her ability to carry out the responsibilities of this
job. To help Mary get this job, you must do the following:

COMPREHENSIVE PrOBLEM <«

Welcome back to the Agee Candy Company! It looks like the work is beginning
to back up at your desk. Your In Box seems to have more paper in it than the
annual congressional budget bill. The item on top of your bin is an assignment
to change the list of personnel that you completed yesterday. Ask your instruc-
tor to assist you in opening the file. The file was saved as Employees. Make the
following changes to the list.

Add the following:

SUMMARY, KEY TERMS/COMMANDS, SELF-QUIZ,
AND FILL-IN QUESTIONS

At the end of each chapter we conclude the lesson with a summary and a list
of key terms. The summary reviews the important topics covered in each les-
| son while the list of key terms calls attention to a series of important concepts,
commands, and procedures highlighted throughout the text. In addition to the v
| summary and key terms, we have included numerous questions that help the
r‘ reader review important concepts in the lesson. The review questions tend to
| be open-ended, discussion-type questions. The self-quiz questions are multiple
| choice questions. These multiple choice questions are followed by a series of fill-
in-the-blank questions. As students review and try to answer these numerous
questions, they are reinforcing important topics covered throughout the lesson.
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HANDS-ON PROJECTS

As all of us who teach microcomputer applications know, there is no substitute
for hands-on activities. Each lesson concludes with a series of application proj-
ects. The first group of application projects reviews the activities introduced
throughout the lesson. The latter group of applications combine the activities
of the current lesson with activities of previous lessons. Throughout these appli-
cations students create their own files and use them throughout the entire text.
Following these application projects are a set of applications we call Data Disk
Applications. These data disk applications are hands-on projects the students
are asked to complete based on a set of files provided to the instructor of the
class. Finally, each lesson concludes with a Comprehensive Problem based on a
fictitious candy company and an extensive list of employees. With the compre-
hensive problem students are asked to carry out a number of the activities
learned in the lesson, and they are encouraged to experiment on their own.

ANCILLARY MATERIAL

e Instructor’s Guide. We have written our own instructor’s guide for
each Effective text. Most authors do not write their own instructor’s
guides. We felt it was important, however, to ensure that our instructional
pedagogy was available to instructors who use these types of resource
manuals. In our instructor’s guide, we have detailed outlines of each les-
son, lecture tips, helpful hints, and assignment suggestions that will help
ensure that students master the material presented in each lesson, The
instructor’s guide also includes answers to review questions, self-quizzes,
and fill-in questions.

¢ Student Data Disk. Accompanying the Instructor’s Guide will be a stu-
dent data disk containing exercises for the students to work through. By
using these hands-on exercises the student will gain a more thorough
understanding of the material presented.

ACCURACY

Class time is important. You shouldn’t have to use your class time trying to deal
with an inaccurate activity. All of the books in this series are developed as care-
fully as possible to ensure their quality and accuracy.
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LESSON 1 OBJECTIVES
° After completing this lesson,
you will be able to
G e ttl n g S t a rt e d @ Identify the purpose of
Microsoft Word.
® Create a data disk.

Start Microsoft Word.

Identify the components

of the opening screen.
Identify the major items
in the menu bar.

Explain the purpose of a
toolbar.

Explain the purpose of
the status bar.

Use the Help feature.
Use Menu commands.

Exit Microsoft Word.

WHAT IS MICROSOFT WORD?

Microsoft Word is one of the most popular word processing programs available.
It is an exceptionally powerful word processing program and, because it uses
the popular Microsoft Windows environment, it is very easy to learn and use.

What makes Microsoft Word so powerful is its full range of word processing
features. These features range from a very simple method of entering and edit-
ing text to being able to incorporate graphics and change the appearance of
text. By combining the easy-to-use Microsoft Windows environment with the
powerful features of Microsoft Word, you can create almost any document
quickly and easily.

Two of the most attractive features of Microsoft Word are an uncluttered
workspace and readily accessible command buttons. (See Figure 1-1.) Micro-
soft Word is designed so you only need to learn a few basic features to begin
creating documents. As your requirements increase, you will only need to learn
a few more features and commands to create even more elaborate documents.

In fact, the easiest way to learn Microsoft Word is to begin creating very sim-
ple documents. From these documents you will learn new features and com-
mands and increase your ability. By going step by step and building on your
knowledge, you will rapidly become an experienced user of Microsoft Word.

BEFORE YOU BEGIN

Before you begin, you must make sure that your software is correctly installed
on a hard disk or a Local Area Network (LAN). Correct installation ensures that
the computer and the connected printer will operate properly. If Microsoft Word,
Microsoft Windows, or your printer have not been correctly installed, consult
the appropriate installation guides.
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Times New Roman

Lesson 3
Manipulating Records and Tables

OBJECTIVES
After completing this lessom, you will be able to
successfully
Examme the contents of a table.
Insert and delete records.
Copy, rename, and delete tables.
Add, delete, and copy fields.
Modify field names.
Add, edat, and delete data and records.
Copy, rename, and add tables and objects.
Use Quick Soxt.
Use Table Wizards to generate new tables

OVERVIEW
Now that you have had an opportuntty to develop your

All data files created within each lesson should be saved on a floppy disk.
More specifically, all examples used in this book use the A: drive as the loca-
tion for saving and retrieving files. These include files created with activities,
exercises, and application projects. You must have a formatted floppy disk to

accomplish these and other tasks. For those unfamil-
iar with formatting data disks, the next section pro-
vides a brief overview of formatting in Microsoft Win-
dows 95. In addition, you may consult the Microsoft

Learn Microsoft Windows 95 Windows 95 text in this series or a Windows 95 ref-

erence guide.

You should have a basic understanding of Microsoft

Windows 95 before trying to learn and use Microsoft
Word. Windows (as it is commonly called) is an operat-

Formatting Disks

ing environment that controls the way you interact All information entered into a computer resides in
with the computer. It is easy to lose valuable informa- memory. This memory is known as random access
tion if you do not understand how to use Windows. memory, or RAM. RAM performs the very important
Take some time now to learn about Windows. It may function of storing information, but it has one major

save a great deal of time later.

drawback. When the computer loses power, the com-

puter loses the contents of RAM. Turning off the

power with data in RAM means losing the data. The
best way to avoid this is to take the information from RAM and store it on an
outside source before you turn off the computer. For this module, that outside
source is a floppy disk.

However, before you can store any information on a floppy disk, you must
prepare the disk to receive the information. The process of preparing a disk for
use on a computer is called formatting.

Formatting a disk using Microsoft Windows 95 begins by using the My Com-
puter program, typically found on your Windows desktop. To access the My
Computer program double-click on the My Computer icon. A window containing
several icons appears, including an icon for each available drive location. Icons
appear for each floppy drive (A and B), each hard drive (C and possibly others),
and any other devices such as a CD-ROM drive (D or other label). Each type of



